
White Lion Meeting Edition – Quick Reference Guide  
 
Welcome to a world where remote meetings are more productive. Welcome to a place where you hear and 
see your participants, even though they are time zones apart. Welcome to White Lion Meeting Edition. You 
now have a tool that allows you to see, hear and engage as if everyone is in the same room. 
 
With White Lion Meeting Edition, your online meetings are easy to organize and conduct. Simply schedule 
and invite participants to your meeting using Microsoft Outlook®. When you are ready to meet, participants 
just click the White Lion Meeting Edition link in your invitation and are instantly placed into your meeting 
space. It’s that easy. You have the tools to control the meeting, engage with participants and ultimately, get 
work done more efficiently. 
 
The following guide delivers quick steps to start or join a conference, as well as great tips for managing your 

remote meetings. MEETI 
 
PLAN YOUR MEETINGCIPATE NG 

 Content Management Pages  
 
Raindance content management pages enable you to manage your pre- and post-meeting activities. 
Whether you want to view and manage recorded meetings, store documents, access reports or create and 
edit polling questions, your content management pages allow you to do it all. 

Q: How do I access content management pages?  
A:  Click on the URL located on your home screen in White Lion Meeting Edition. You can also direct your 

participants to your content management pages to view stored documents or listen to recorded meetings. 

 Send Meeting Invitations 

Q: Can I use Microsoft Outlook® to invite participants to a meeting? 
A:   Yes. However you must first enable Outlook integration with White Lion.  
  On the Tools menu, click Enable Outlook Integration. 

Q: How do I invite people to a meeting? 
A: There are two ways to invite participants: 

1. Before the meeting – If Outlook integration is enabled, click New White Lion meeting in Outlook. An 
Outlook meeting invitation displays. 

2. Before or during the meeting –  
On the File menu, click Send E-mail Invitation. Your default e-mail program displays. 

 Your e-mail invitation is pre-populated with the meeting login information, and participants join your 
meeting by clicking the link. 

Q: Do participants automatically join a meeting when accepting a Raindance Meeting Edition 
invitation? 
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A: No. By accepting an Outlook meeting invitation, participants schedule the meeting in their calendars and 
notify the moderator. To join the meeting, participants must click the link in the meeting invitation at the 
scheduled time. 

 Polling Questions 

Polling questions are created before or  
during a meeting to gather information  
from participants during the meeting. 

Q: How do I create a polling question set? 
A: To create a polling question set before a meeting: 

1. Log into your content management pages. 

2. Click Question Sets. 

3. Click Create New Question Set. 
4. Name your question set. 

5. Enter your questions. 

6. Enter answers or select answers. 

7. Click Add Question. 

8. Click Save. 

Q: How do I add a new polling question? 
A: To add a new question to an existing polling question set: 

1. Select the Add Question tab. 

2. Click the pencil icon next to the question set you want to modify. 

3. Enter your question. 

4. Enter either custom answers or select from pre-set answers. Each custom  
answer must be on its own line within the field. 

5. To allow more than one answer to be chosen, select Allow participants to select  
more than one answer. 

6. Click Add Question. 

7.  Click Save. 

 Stored Documents 

Stored documents are documents uploaded to your content management pages and made  
available to your participants for download.  

Q: How do I upload a new stored document? 
A: To upload a new stored document: 

1. Click Stored Documents from your content management pages. 

2. Click Upload New Stored Document. 
3. Complete the document details. 

4. Specify who can access the document. 
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5. Click Upload Document. 

 Billing Codes 

Billing codes are numbers you assign to meetings that enable you to track expenses in order to charge a 
conferencing fee back to a client or an internal group. To activate the billing code feature, contact 
clientservices@uswhitelion.com.  
 
Once this feature is active, you are prompted when starting a meeting to enter a billing code or choose a 
previously used billing code from the menu in the billing code dialog. On the phone,  
you are also prompted to enter a billing code on your phone keypad. If there is not a billing code associated 
with your meeting, click Cancel when the billing code dialog appears and press pound (#) on your phone 
keypad when prompted to enter a billing code. 

Q:  How do I change a billing code for a meeting after the meeting has ended? 
A: To change a billing code entered in White Lion Meeting Edition:  

1. Click Manage Your Account on your home screen to access  
your meeting reports. 

2. View the Details of your audio or web report.  

3. Click Edit next to the existing billing code. 

4. Enter the new billing code into the New Billing Code field. 

5. Click Update. 
 

 Additional Security 

Q: What are passcodes? 
A: Passcodes are four- to nine-digit codes that provide an additional layer of security for your meeting. In 

your profile, from the Security tab, select Prompt me to set a new passcode for every meeting. 
Participants joining a meeting secured by a passcode must enter the passcode before they can join. 

 
 You can also require a security passcode before participants can join the phone portion of your meeting. To 

enable this feature, contact clientservices@uswhitelion.com. 

Q:  How do I create a new passcode? 
A:  To create a new passcode within White Lion Meeting Edition: 

1. On the File menu, click Edit Profile. 

2. Select the Security tab. 

3. Choose Prompt me to set a new passcode for every meeting in your profile.  

4. Start a new meeting. The passcode dialog displays. 

5. Enter the passcode in the field or choose a previously used passcode from the  
drop-down menu. The passcode must be four to nine digits. 

6. Click OK. Your participants are prompted to enter that passcode when joining  
your meeting. 

 
 To create a new passcode on the phone: 
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1. Connect to the phone portion of the meeting. 

2. When prompted, enter a passcode on your phone keypad, followed by the pound (#) key. 

3. Confirm the passcode. 

Q:  How do participants know the passcode for my meeting? 
A:  To ensure participants know the passcode for your meeting, it must be included in the meeting invitation. 

If you are inviting participants before or during a meeting by sending an e-mail  
invitation through White Lion Meeting Edition, your passcode is automatically inserted.  

 
Q: How do I give my meeting participants the passcode? 
A:  Before you start your meeting, create your passcode. If you already selected to set a new passcode for 

every meeting in your profile, click White Lion Meeting Information in your Outlook invitation and enter 
the passcode in the passcode field. If you did not select Prompt me to set a new passcode for every 
meeting, you must enter the passcode directly into your meeting invitation. During your meeting, if you 
send an e-mail invitation to a new participant through White Lion Meeting Edition, the passcode is 
automatically inserted into the invitation.  

 
 If you are using a passcode for the phone portion, you must also include this information  

in your invitation. 

Q:  Can I encrypt my meeting for additional security? 
A: To encrypt specific meeting features: 

1. On the File menu, click Edit Profile. 

2. Select the Security tab. 

3. Select the checkbox by the features you want to encrypt. The following features can be encrypted: 
Document Viewing/Whiteboarding, Application Sharing/Browser Sharing, Participant Information, 
Chat, Video, Polling and Question & Answer. 

4. Click OK. 
 
 To end feature encryption, clear the checkbox for that feature. If you change your feature encryption 

settings during a meeting, you must first log out and then log back in for changes to take effect. 
YOUR MEETING 

ACCESS YOUR MEETINGC 

 
Start a Meeting 

 Q: How do I start a meeting? 
A: From your Raindance Meeting Edition home screen, click Start a Meeting. You are prompted to select 

or enter a phone number. You will be called at this phone number to start the phone  
portion of the meeting. 

 

Q:  How do I set the default role of participants joining my meetings? 

Last Modified 8/2/05 
4 



A:  As the meeting moderator, you assign meeting participants a default role.  
You can also change their role or choose to set unique feature permissions for each meeting. 

 To change the default role for your meeting participants: 

1. On the File menu, click Edit Profile. 

2. Select the Meeting Info tab. 

3. Choose a default role from the drop-down menu. 

4. Click OK. 

Q:  How do I change my profile information? 
A: To change your profile information: 

1. From your White Lion Meeting Edition home screen, click Manage Your Account. 
2. Click Change next to Your Personal Info. 

3. Edit the fields to change your profile information. 

4. Click Change. 

Q: How do I choose what profile information is shared in a meeting? 
A:  To choose your profile information shared in a meeting: 

1.  On the File menu, click Edit Profile. 

2. Select the Share In Meeting check box of the profile information  
you want to share. 

3. Click OK.O 
 

CONDUCT YOUR MEETINGCDUCT YOUR MEETING 

 Live Desktop Video 

Q:  What equipment do I need to use video? 
A:  To be seen by other meeting participants, install a web camera before starting or joining a White Lion 

Meeting Edition meeting. Your web camera transmits live video of you to other  
participants during a meeting. 

  
If you do not have a web camera, you can participate in a meeting and see other participants’ video, but 
you are not able to send live video. 

Q: How do I know if my video is working? 
A: If your web camera is installed and on, you will see your live video displayed in the Meeting Bar.  

Q: Can I turn my live video off so participants cannot see me? 
A:  Yes. Click the double arrows above the video window to collapse the Video controls.  

The status will change from on air (transmitting video) to off air (not transmitting video). 

Q: How can I see other participants’ video? 
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A: In the Participants controls, select the name of the participant you want to view. Their video is displayed 
to you in the Video Task Group. 

Q:  How can I see live video of the person speaking? 
A:  Use the follow talker feature to display the live video of the meeting participant currently speaking. Other 

participants can override follow talker by selecting  
take podium, which then displays their video. 

  
To follow talker: 

1. In the Video Task Group, click Video Options. 

2. Click Follow Talker and a check will appear to indicate you are now following the talker.  
To quit following the talker, click Follow Talker again to clear the check. 

Q: How do I know if someone is viewing my live video? 
A: To see who is watching the live video of another participant: 
  
  

In your Private Workspace, select Details from the View drop-down menu. The Viewing column shows 
who that person is watching. When you take the podium, all participants are forced to view your live 
video. 

Q:  What if I do not have a web camera? 
A:  If you do not have a web camera, you can participate in a meeting and see other participants’ video, but 

you are not able to send live video.  

 Presenting or Sharing Content 

Q: What options do I have for presenting or sharing content? 
A: You can convert a document using Document Viewing, share an application using Application Sharing or 

share a browser using Browser Sharing. 

Q:  Why should I convert a document in Document Viewing rather than share it using Application 
Sharing or Browser Sharing? 

A: Converting a document gives you the following benefits: 
• Less bandwidth: minimal bandwidth is required for viewing. 
• Quick retrieval: converted documents are stored in the My White Lion Documents directory for easy 

retrieval later. 
• Easy access: converted and presented documents are saved in Meeting History for participants to 

view at any time during your meeting. 

Q:  What are the benefits of Application Sharing or Browser Sharing? 
A:  The benefits of sharing are: 

• Quick presentations viewed on-the-fly; no conversion is necessary. 
• Browser sharing is live, enabling real-time presentations. 
• Any desktop application can be shared with participants. 
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 Sharing an Application or Browser 

Q: What is sharing an application or browser? 
A: You can present an application or web browser from your computer during a meeting. You can share a 

specific file, a selected region of your desktop or your entire desktop for other participants to view and 
annotate. If given permission, a meeting participant can do the same. 

Q:  How do I share an application? 
A:  To share an application: 

1. In the Meeting Bar, click Application Sharing. Icons for open applications and desktop and region 
sharing icons are displayed in your Private Workspace.  

2. Click any application icon to begin sharing that application, click Share Desktop to share your entire 
desktop or click Share a Region to select a specific region of your desktop for sharing. 

Q:  How do I share a browser? 
A:  To share a web page: 

1. In the Meeting Bar, click Browser Sharing.  

2. Enter a web address in the URL field displayed in your Private Workspace or choose a previously 
viewed web address from the drop-down menu. 
You can take users to any web site, secure (password protected) or non-secure. 

 Document Viewing 

Q:  Why do I need to convert my documents before presenting? 
A:  Before you can present a file with Document Viewing, you must convert it. When a document is 

converted, it is saved as a White Lion document on your hard drive. Conversion does not change your 
original document; it simply saves it in a format that enables easier presentation during the meeting. You 
can convert documents before or during a meeting. A converted  
document can only be viewed while using White Lion Meeting Edition.  

Q: What types of documents can be converted? 
A: The following file types can be converted and presented in White Lion Meeting Edition: *.doc, *.ppt, *.vsd, 

*.xls, *.txt, *.pdf, *.prz, *.jpg, *.jpeg and *.bmp. 

Q: How do I convert a document? 
A: To convert a document: 

1. In the Meeting Bar, click Document Viewing. 

2. Click Convert a Document. 
3. Select the file you want to convert and then click Open.  

4. When conversion is complete, click Open in Meeting to immediately open the converted file for 
presentation in your Private Workspace or click OK to return to your meeting. 

 Recording 
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Recording lets you capture a synchronized audio, web and video playback of your meeting. After the 
meeting, make the recording available to others for later playback. 

Q: How do I record a meeting? 
A: To record a meeting: 

1. In the Meeting Bar, click Recording Controls. 

2. Click Start Recording. 

3. Enter a title for the recording. 

4. Select Include webcam video in recording to include live video in the recording. Clear the 
checkbox to omit live video from your recording. 

5. Click Start Recording.  
 

 When recording begins, Recording In-Progress will display above your Public Workspace and you will 
also hear "your conference is now being recorded" on the phone. 

 Question & Answer 

Question & Answer enables co-moderators, presenters and participants to ask text questions  
during a meeting, if given permission. Moderators, co-moderators and presenters can answer  
questions. 

Q: How do I know when a question is being asked? 
A: There are two ways to determine when a question is being asked. 

1. When the Question & Answer feature is open, questions are displayed in your Private Workspace. 

2. When the Question & Answer feature is not open, the Question & Answer option in the Meeting Bar 
will flash. 

Q: How do I answer a question using Question & Answer? 
A:  To answer a question: 

1. In the Meeting Bar, click Question & Answer. The Question & Answer interface appears in your 
Private Workspace. 

2. Click a question in the Questions Outstanding box. 

3. Enter an answer in the Answer box. 

4. Click Answer to answer the question privately or click Answer to All to answer publicly. 

 Polling 

During a meeting you can gather real-time feedback from your participants and  
publish the polling results. 

Q: How do I ask a polling question? 
A: To ask a polling question: 

1. In the Meeting Bar, click Polling. The Polling interface appears in your Private Workspace. 

2. Select a question set.  
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3. Click Open Poll.  
 

 As meeting participants answer the polling question, their responses display in your Private Workspace. 
When you are ready, close the poll and publish the results. 

Q: How do I create or update a polling question set while in a meeting? 
A: To create or update a polling question set while in a meeting: 

1. In the Meeting Bar, click Polling. The Polling interface appears in your Private Workspace. 

2. Select either an existing question set to edit or choose New Question Set from the drop-down menu 
to create a new question set. Click Edit Question Set. 

3. Create or update the question set. 

4. Click Save. 

 Chat 

Chat enables you to exchange text messages with all meeting participants, moderators, co-moderators or 
specific participants. 

Q: How do I chat with participants? 
A: To chat with individual participants: 

1. In the Meeting Bar, click Chat. The Chat dialog box opens. 

2. Choose an appropriate recipient for your message. 

3. Enter your message in the text entry field at the bottom of the Chat dialog box. 

4. Click Send.  
 

 Your message is displayed in the upper area of the Chat dialog box. When you receive a message, it is 
posted in the same area. 

 Annotation 

Q:  Can I annotate a presentation or shared application? 
A: Yes. You can select an annotation tool to draw or write notes while whiteboarding, presenting a document 

or when application sharing or browser sharing is paused.  

Q:  What is Meeting History? 
A: Meeting history displays presented whiteboards, presentation slides or any other converted document 

that has been presented in your meeting. 
 

To view Meeting History in your meeting: 

1.  On the Meeting Bar, click Document Viewing. 

2.  Select Meeting History from the drop-down menu in your  
Private Workspace. 

 Force Fullscreen  
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For even more control over a participant’s view, you have the option of forcing all participants into full-screen 
mode. 
 
To force full screen for your participants, click the force full screen icon. To return your participants' 
screens to the normal view, click the force normal icon. 
 

POST-MEETING ACTIVITIESTIES 

 Reports 

Reports are available within your content management pages and allow you to access information about 
your meetings. 

Q:  How do I generate a report? 
A: To generate a report: 

1. Click Reports in your content management pages. 

2. Select a date range. 

3. Choose a report type. 

4. Apply a filter. 

5. Click Run Report. 

 Recording 

Q: How do I make my recorded meeting available to others? 
A: There are two ways to make your recorded meeting available to others: 

1.  Send an e-mail containing a playback link. 

2. Download the recorded meeting and Raindance player. 

Q: How do I send out a playback link from my content management pages?  
A: To send a playback link: 

1. Click Recorded Meetings in your content management pages. 

2. Click the envelope icon next to the meeting for which you want a link. You will receive a link via e-mail 
and can then forward it to recipients. 

Q: How do I download a recorded meeting from my content management pages? 
A: To download a recorded meeting: 

1.  Click Recorded Meetings in your content management pages. 

2.  Click the orange arrow icon next to the meeting you want to download. 

3. View confirming information on the following page and click  
Download Recording. 

4. Click Save in the file download dialog box. 

5. Select a location to save the recording and click Save. 
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 The Raindance player is needed to playback a downloaded White Lion meeting.  

Q: How do I play back a recorded meeting from my content management pages? 
A: To play back a recorded meeting: 

1. Click Recorded Meetings in your content management pages. 

2. Click the green arrow icon next to the recording you want to play back. 

3. If the recording is password-protected, enter the password. 

4. Choose your network connection speed by clicking Low, Medium or High.  

5. Click Play Recorded Meeting. The Raindance player displays and the recording  
begins to play. 

 

 

PARTICIPATE IN A MEETINGCIPATE 

Q: How do participants join a meeting? 
A: There are three ways participants can join a White Lion meeting: 

 
1) Once White Lion is installed, double click the Raindance desktop icon. 

1. Click Join a Meeting. 

2. Enter the conference ID provided by the moderator or select a previously entered conference ID from 
the drop-down menu. 

3.  Click Join Meeting. Participants are either placed directly into the meeting or are instructed to wait 
for the moderator. 

 
2) An e-mail invitation:  

1. Click the meeting link in the e-mail invitation.  
If participants accepted an Outlook meeting request, they must open the appointment in their 
calendars and click the link.  

2. Enter the required information and the conference ID provided by the moderator. 

3. Select either the full version or light version depending on individual operating systems and/or 
bandwidth. 

4. Click Join Meeting. 

 
3) The White Lion web site:     ************************************************************ 

1.  Go to http://www.raindance.com and click Join a Call/Meeting 

2.  Enter the required information and the conference ID in the Raindance Meeting Edition box. 

3.  Select either the full version or light version depending on individual operating systems and/or 
bandwidth. 

4. Click Join Meeting. 
 

 In any of the above cases, when the moderator arrives, participants are prompted to select or enter a 
phone number to join the phone portion of the meeting. Participants are called at this phone number and 
joined into the phone portion of meeting. 

Q:  How do I assign a new role or set custom permissions for a specific participant in a meeting? 
A: To assign a new role or set custom permissions for a meeting participant: 
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1.  In the Meeting Bar, click Participant Details. A list of participants appears in your Private 
Workspace. 

2.  Right-click the participant’s name and click Permissions. 

3.  Choose a new role (co-moderator, presenter or participant) or select check boxes to add permissions 
or clear check boxes to take away permissions. 

 
 These permissions and roles apply only to your current meeting. When you start a new meeting, the 

default role you specified in your profile is assigned to those participants. 

Q: How do I join participants into the phone portion of a meeting? 
A: When you start the phone portion of the meeting, participants are prompted to verify a phone number 

where they will be called. You do not need to manually call participants.  

Q: How do I dial out to a participant from within a meeting? 
A: To dial out to a participant: 

1.  In the Meeting Bar, click Participant Details. A list of participants appears in your  
Private Workspace. 

2.  Right-click on the participant's name in your Private Workspace, then click Call. 
3.  Select or enter a phone number. 

4.  Click OK. 

Q:  How do I mute and unmute participants’ phones? 
A: To mute all participants' phones, click the mute all audio icon in the main toolbar at the top of the 

application. To unmute all participant phones, click the unmute audio icon.  
 
 To mute or unmute individual participant phones: 

1. In the Meeting Bar, click Participant Details. 

2. Right-click on a participant's name in your Private Workspace, then click  
Mute or Unmute. 

Q:  How do participants connect to the phone portion of a meeting after they’ve joined online? 
A: To join the phone portion of a meeting: 
 If the moderator has already started the phone portion, participants are prompted to select or enter a 

phone number where they will be called. Or, they can dial into the meeting. In the Meeting Bar, click 
Meeting Information then click Dial-In Instructions. Follow the instructions. 

 
If the moderator has not started the phone portion when participants join online, they will be able to request 
that the meeting call them once the moderator arrives. In the Meeting Bar, click Phone Controls. The 
Phone Controls Task group appears. Click Join Phone Conference. 
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